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Chapter 1.   Introducing Licensing
Compuware’s Client/Server License Management software facilitates the license 
management and administration needs for your Compuware products. Licensing your 
Compuware product depends on several factors:

� The type of license file you received from Compuware

� The number of users specified in your license file

� The location of the License Manager

This document provides all of the necessary information to get you started installing your 
Compuware product to administer the necessary licensing components. Compuware’s 
licensing software consists of the following key components:

� The License Manager (LM) - A long running process that services requests for a 
license that can be installed on many platforms.

� The License File (license.dat) - A data file that contains information about the 
Compuware products (clients and locations) and the License Manager.

� The License Administration Utility (LAU) - A Windows-based GUI to the 
License Manager, license file, and Borrowing components, typically installed in 
your product directory. See Chapter 5, “Using the LAU”.

� Version 3.2 of Compuware’s Client Server License Management product also 
comes with the following components: the Compuware Service Handler, the 
Borrow Proxy Server, and the Borrow License Client.

If you did not receive a license file from Compuware with your new product, you 
probably have a Time-Limited Trial license which will install with your product. This 
Trial license will allow you to use your Compuware product for up to 30-45 days, 
depending on the product. Each time the product runs, you will be asked to install a 
permanent license, or to continue the trial. Before the trial runs out, you should purchase 
a Permanent license from Compuware. See “Request a License from Compuware” on 
page 5-11.
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Compuware offers two licensing models:

You can determine your licensing model using the following guide:

Node-Locked: You have a Node-Locked license model if the FEATURE line in the 
license file is followed by a "HOSTID=" string. 

Concurrent: Your license file contains SERVER or DAEMON lines.

Trial License: If you do not have a physical license file, you have a Time-Limited trial 
(Node-Locked) license shipped within the product.

Licensing Process
The first step in the licensing process is to determine whether or not it is necessary to 
install and run the License Manager. Even though most licensing installations require the 
License Manager, if you are installing a Compuware product for the first time and you 
don’t have a license file, then you probably do not need to install any licensing 
components. That is because most Compuware products ship with a Time-Limited Trial 
license that does not require special installation. So, if you have not purchased the product 
yet, and are preparing to install a trial copy, you will not need to install the License 
Manager. After your trial period ends and you purchase a permanent license file from 
Compuware, you will have to configure the License Manager (unless it is a node-locked 
license). 

The License Manager is a long running process (or license server) for multiple client 
machines, so typically, only one server machine per shop will install the LM, and the rest 
will just connect to it through Compuware’s License Administration Utility. 

Table 1-1.  Compuware License Models

License Model Description

Concurrent (Floating) Server-based. Shared LM with more than one user. 
This model will have a license file with SERVER and 
DAEMON lines. It allows you to purchase a specific 
number of licenses without assigning them to a 
particular workstation. When all available licenses 
are checked out, no additional users can run the 
product until a license is checked back in. This 
process is handled by the License Manager.

Node-Locked Client-based. Single user license file. LM installation 
is not required, but can be used. A Node-Locked 
license is denoted by the HOSTID keyword found in 
the license file.
  



Introducing Licensing     1-3
The following figures show product and licensing configuration for both pre-purchase 
and post-purchase of a Compuware product. 

 

Figure 1-1. Typical License configuration for Trial Period 

Figure 1-2. Typical License Configuration for post Trial Period (after purchase)

The configuration for a Trial period is the same as the configuration for a permanent 
Node-Locked license; meaning: it is not necessary to install the LM for a Node-Locked 
single-user license. It is optional for the LM to serve licenses for Node-locked licenses, 
but it is mandatory for the LM to serve licenses for concurrent license types.

When you receive the permanent license file (license.dat) from Compuware, it will 
indicate whether or not installation of the LM is required. If the license file contains 
SERVER or DAEMON lines (case-sensitive strings indicating that it is a Concurrent-user 
license), then installing or updating the LM is required. If it contains the string 
“HOSTID=”, then the license is Node-Locked. To check the license file for these strings:

1. Open the License file:

• Windows: Open in Notepad or DOS EDIT.
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• UNIX: Use the VI Editor.

2. Search for “SERVER” or “DAEMON”, or conversely, search for “HOSTID”.

3. If these terms are found and they are not commented out with a “#”, then instal-
lation of the LM is required. See “Licensing when the LM is Required 
(Concurrent)”. If these strings are not found, begin product installation to see if the 
product is shipped with a Trial License. See “Licensing when the LM is not 
Required (Node-Locked)”.

Licensing when the LM is Required (Concurrent)
Trial periods are not run concurrently, so if you have not purchased a product or received 
a license from Compuware, then you can only run a Trial Node-Locked license. When the 
LM is required, the license file will contain SERVER or DAEMON lines and is 
considered to be "concurrent" or "floating". A server-based license allows you to run a 
Compuware product on more than one client so that multiple users can access the product. 
This means that you purchase a specific number of licenses without assigning these 
licenses to particular clients. 

The Compuware License Manager (LM) keeps track of licenses as they are "checked out" 
and "checked in" by users. Licenses are "checked out" by users on a first-come, first-
served basis when they access the product. After all available licenses are issued, no 
additional users can run the product until another user exits and a license is "checked in." 
Your license determines how many users may access the product at one time.

The LM must be running on a computer or server that is always available to all clients 
needing access to the product. Only set up an LM on a server if your license has SERVER 
or DAEMON lines. The LM can be installed on any of the following Servers:

� For Windows, see Chapter 2, “License Installation and Management for 
Windows”.

� For UNIX, see Chapter 3, “License Installation and Management for UNIX”.

� For Novell, see Chapter 4, “License Installation and Management for Novell”.

Licensing when the LM is not Required (Node-Locked)
If your FEATURE line in the license file is followed by a “HOSTID=” string, you have a 
Node-Locked license. See “HOSTID” on page C-3. When you have a node-locked 
license, installation is very straight-forward: it is either Silent or Manual. If you are 
updating a Trial license to a permanent license, see “Manual License Installation” 
below. If you are installing a product for the first time and want to run a trial, see “Silent 
License Installation”.
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Silent License Installation
A silent installation is possible when you install a Compuware product, it will 
automatically install a Trial license for you. The Trial license file will be installed locally. 
Each time you run the product, you will be informed of the time remaining on your trial 
license. 

After the Time-Limited Trial period ends, you will receive a permanent license (if you 
purchased one) and you will need to manually update your licensing environment. See 
“Manual License Installation” below.

Manual License Installation
You may have to manually install the licensing components if you received a license file 
from Compuware and did not use a Trial license, or if you are updating a Trial license to 
a permanent license. See “Current License Environment Setting” on page 5-3.

Supported Platforms
The following table lists the platforms upon which CSLM components can be installed, 
licensed, and run. 

Table 1-2.  Supported Platforms

Platforms
License a 
Product

Install License 
Manager

Install Borrow 
Proxy Server

Install Borrow 
Proxy Client

Alpha Open VMS x - - -

DEC x x x -

HP-UX (32-/64-bit) x x x -

IBM-AIX (32-/64-bit) x x x -

Linux x x x -

Novell - x - -

Reliant x x - -

Sun-Solaris 2.x (32-/
64-bit)

x x x -

Windows - 95, 98, NT 
4.0, ME, 2000, XP

x x x x
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Getting Started
The remaining chapters in this manual discuss setting up the License Manager on 
different platforms as well as how to administer the License Manager with the License 
Administration Utility (LAU). 

When you receive your license file from Compuware, copy the file onto a location on 
your disk and put it either:

� In the product directory for node-locked models. See “Current License 
Environment Setting” on page 5-3.

� With the License Manager for concurrent models. See “Configure Clients to 
access the LM on Windows Server” on page 2-5.

To begin setting up the License Manager, refer to the chapter for your platform:

� For Windows, refer to Chapter 2, “License Installation and Management for 
Windows”.

� For UNIX, refer to Chapter 3, “License Installation and Management for 
UNIX”.

� For Novell, refer to Chapter 4, “License Installation and Management for 
Novell”.
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Chapter 2.   License Installation and Management for 
Windows 

The procedures in this chapter will describe how to install the License Manager on a 
Windows Server. You can use Windows 95, 98, NT, ME, 2000, or XP as the server to host 
the License Manager. Installation of the license manager is only necessary for Concurrent 
license types (a SERVER or DAEMON line is present in the license file). Installing the 
License Manager is NOT necessary if you have a node-locked license (see Licensing 
when the LM is not Required (Node-Locked). 

The following steps may be necessary to install and operate the LM in your environment:

� Install the License Manager and its components
� Configure the LM and Borrow Proxy Server to run as Services with the Compuware 

Service Handler
� Configure each client to access the License Manager
� Configure each client’s Borrow License Client application to talk to the Borrow 

Proxy Server
� Create an Options file

Note: if you are upgrading to version 3.2 of Compuware’s Client Server License 
Management software, you must install the License Manager and all of its components to 
enable License Borrowing and the Compuware Service Handler.

License Manager Installation
The following procedures walk you through the installation and configuration of the 
License Manager and the Borrow Proxy Server.

Note for System Administrators of the LM: If you are updating a license file only (not 
the LM), it is recommended that you merge the new license file with the old one. After 
the new license file is merged, use the Compuware Service Handler to "Reread" the new 
Master License file.
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1. From the Compuware Product's installation CD, select Install License Manager. 
This will start the InstallShield Wizard for the License Manager. You will need to 
navigate through several screens. Proceed to step 2 when asked for the location of 
the License Manager.

2. If you use a directory other than the default for the LM Install directory, you must 
Uninstall the original LM and reboot before installing the new version of the LM.

3. At the end of the installation you will be asked if you currently have a license.

4. If you have a license file, select Yes and the License Installation screen will appear 
(see “License Installation dialog for the License Manager” on page 2-4). If you 
select No, you will need to use the Compuware Service Handler at a later date to 
configure the Licensing Environment.

5. If this is the first Compuware product installation, choose a location for the Master 
license file in the Target field. It will default to “C:\Program Files\Common 
Files\Compuware\license.lic.” If you already have a Master license file and you 
want to add the new license file to it, navigate to the Master license file and place it 
in the Target field (this is what the example in Figure 2-2 shows).

• If placing the license file in a different directory than compuwar.exe, update the 
daemon line of the license file to contain the full path of the compuwar.exe file.

6. For the Source field, navigate to the new license file and select it. Click Continue. If 
you do not specify a source License file, the Installation will be complete. To 
specify a license file, run the LAU and then start the Compuware Service Handler 
and specify a license file and click Start Service.

7. After Continue is selected, one of two things will happen:

• If a license file already exists in the Target location, a message will appear 
informing that the there are backups being created. The License Install dialog 
will then run the files through a Merge algorithm. See “Merge License Files 
dialog” on page 5-6.

• If the license file does not already exist in the Target location, the Source file 
will be copied there. 

8. The License Installation screen will then close and the Compuware Service 
Handler dialog will open (see note below). The license specified in the previous 
screen will be present as the current license file. A log file will also be created. The 
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Compuware Service Handler will not open at this time if the current machine's Host 
Name and HostID do not match the Host Name and HostID present in the License 
File. The file displayed in the License file field should be the Target license from the 
License Installation sceen.

Figure 2-1. Compuware Service Handler dialog

9. Click the Start Service button to start the LM as a service. You will be asked if you 
"Want to run the LMGRD as a Service the next time you start the system." If you 
do, click yes. If you click No, you will have to manually start up the LM each time 
the server reboots.

10. If it is already installed as a service, you will get multiple messages pointing this 
out. Also, the log file will be written to and automatically opened.

11. After the automatic Service Installation, the license is automatically scanned and 
checked for the BORROW keyword. If it is present, the following screen appears:

12. If you select Yes, the Borrow Proxy Server screen displays with the current 
Machines Server Name and Port Number Fields already displayed. If the keyword 
BORROW is present in your license file, the Borrow Proxy Server MUST 
ALWAYS run in conjunction with the LM, even if Borrowing will not take place. 

13. Click Start Service. You will be asked the following: "Do you want to run BPS 
automatically when you restart your system?" If so, click Yes. If you click No, you 
will have to manually start the BPS each time the server machine reboots.
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14. You will get a message indicating whether or not the installation of the BPS as a 
Service was successful. 

• For Windows NT, 200, and XP, the Borrow Proxy Server GUI is only a portal 
to the service itself, so you may close the dialog. For Windows 95, 98, and ME, 
the dialog itself must remain open (minimized is fine) or the BPS will be 
stopped and licenses will not be authorized for checkout.

15. Click Finish on the InstallShield Wizard. 

16. It is also necessary to configure each client's machine to access the License 
Manager (see “Configure Clients to access the LM on Windows Server” on page 
2-5). 

17. If your License File contains the keyword BORROW, you need to set up each client 
to use the Borrow License Client utility (see “Borrow License Client” on page 6-
13).

18. If you are using an Options file, see USER_BASED/HOST_BASED License 
Models.

19. The installation steps are complete. You can access the Borrow Proxy Server, the 
Compuware Service Handler, and the Borrow License Client from the LAU.

License Installation dialog for the License Manager
The License Installation dialog appears during the installation process for the License 
Manager. This dialog contains Target and Source fields and is similar to the Merge dialog 
in the LAU. In fact, if a license file exists in the Target location when Continue is clicked, 
this dialog will behave exactly as the Merge dialog does. See “Merge License Files 
dialog” on page 5-6. You can use this merge process at a later date without installing the 
License Manager. 

Figure 2-2. License Installation dialog. Choose Master License File location
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1. The Target field is used to identify either a new location for the License File, or the 
Master License file location.

2. The Source field is used to identify the new license file. 

3. For more information, see steps 5-8 in License Manager Installation process.

Configure Clients to access the LM on Windows Server
When using a Concurrent license model, each client must be configured to access the 
License Manager. Each client does not need an individual license; they will connect to the 
Master License File that is seated with the LM. The COMPUWARE_LICENSE_FILE 
variable is set using the LAU, which uses a registry setting. This setting is used to connect 
the client to the license file. There are two ways to configure clients to access the License 
Manager:

� Configure Clients with the LAU 
� Configure Clients during Product Installation 

After the client's License Environment is set, verify that the Borrow License Client is 
configured (Borrow License Client dialog) if License Borrowing is enabled.

Configure Clients with the LAU
1. Open the LAU.

2. Click Tools>License Path. 

3. Type in the Port@Host server location of the License Manager in the Current 
License Environment Setting field. Each location specified in the Current License 
Environment Setting field will be scanned when a Compuware product requests a 
license.

4. Click the Append button.

5. Click Apply Changes.

6. Close the dialog.

Configure Clients during Product Installation
It may be necessary to Configure clients during product installation for Concurrent, 
Node-Locked, User-Based, or Trial licenses. During licensing (which may be when the 
product is installed or when the product is first invoked), a dialog box will appear if a 
license is necessary.
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Figure 2-3. Compuware License Install Screen

1. The License install screen is used to connect to either the License Manager or a 
License File; it can also run a Trial of a product. 

• To connect to a License Manager, key in the Port@Host location. If you enter 
the Port@Host location of a License Manager, you will not be required to 
Merge a license file; you will be using the license file that the system adminis-
trator is using in conjunction with the License Manager. 

• To connect to a local license file, select a product in the Product/Version List 
and then type in the path or click Browse and navigate to the license file. If you 
already have a license file, you will be required to Merge the new license file 
with the existing license file. Please see the steps on how to Merge license files. 
After you merge a new license to a Master License File, the previous version of 
the master license file will be archived and named License.dat%.

• To run a Trial, click on a product and leave the path blank. Click continue.

2. If you get the following message: "License Manager must be installed and started 
on this Machine…", then your license file contains a SERVER or DAEMON line 
and the License Manager must be installed first.

3. You will then return to the product installation.

Manually uninstall the LM or Borrow Proxy Server
1. Using a Windows command prompt, navigate to the LM/BPS root directory.

2. For the License Manager, type in: flxsrv.exe -del

3. For the Borrow Proxy Server, type in: bps.exe -del

4. You will be given a confirmation. Click Yes to proceed.
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Install the LM in Windows as Console-Only Mode (Optional)
Compuware recommends the default installation procedure via the Compuware Service 
Handler.

The LM should not be installed as both a console and a service. This procedure applies to 
Windows 95, 98, NT, 2000, ME, and XP, but especially 95, 98, and ME, since they cannot 
run the LM as a Service.

Create Shortcut to Start LM
To create shortcuts for starting and stopping the LM and to place them in the computer’s 
Startup folder:

1. Open the LAU.

2. Click Services>LMGRD.

3. Click the Stop Service button. You cannot run the LM in both Console only mode 
and as a Service.

4. Using Windows Explorer, navigate to the directory where the shortcuts for the LM 
were installed.

5. Create a shortcut named “Start LM”.

6. The “Target” location for the shortcut should be:

<path of lmgrd.exe> -app -c <path of license file>
-l <path of log file>

� <path of lmgrd.exe> is the fully qualified path tolmgrd.exe. If this path 
is a long filename, it should be enclosed in quotation marks.

� <path of license file> is the fully qualified path to the license file. If this 
path is a long filename, you should use its short filename equivalent.
Example: 
“C:\Program Files\Compuware\License\lmgrd.exe” -app 
-c C:Progra~1\Compuw~1\License\license.dat
-b lmgrd.log

The Start in location for the shortcut should be the directory containing lmgrd.exe. If this 
path is a long filename, it should be enclosed in quotes.

To start the LM automatically when the computer is started, make a copy of the shortcut 
and place it in the “Startup” folder.
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Create Shortcut to Shutdown LM
1. Using Windows Explorer, navigate to the directory where the shortcuts for the LM 

were installed.

2. Create a shortcut named “Shutdown LM”.

3. The Target location should be:

<lmutil.exe path> lmdown -c <license file path>
• <lmutil.exe path> is fully-qualified path to lmutil.exe. Enclose in quotes if it is 

a long path name.

• <license file path> is fully-qualified path to license file. Enclose in quotes if it 
is a long path name.

4. The Start in location for the shortcut should be the directory containing lmutil.exe. 
Enclose in quotes if it is a long path name.

Creating an Options File for Windows
If your license agreement allows users on different clients to simultaneously access 
Compuware products, you need to create an “options file.”

1. See Appendix A, “USER_BASED/HOST_BASED License Models” for more 
information about creating an Options file.

2. Test the LM server setup by navigating to the directory where the LM is running 
and executing the following command:

lmutil lmdiag

Updating the License Manager on Windows
Note: if you are upgrading to version 3.2 of Compuware’s Client Server License 
Management software, you must install the License Manager and all of its components to 
enable License Borrowing and the Compuware Service Handler.

If you are hosting the License Manager on a Windows Server, follow the instructions 
below to find out if you need to update or install the LM.

1. Install the License Manager only if no previous version of the License Manager 
exists on the server. From the Compuware product CD, select the option for install-
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ing the Compuware License Manager. Then follow the screen prompts to install the 
LM.

2. Update the LM if a lower version of the LM exists on the server. Compare the 
version number already on the LM server (by opening a DOS prompt and 
navigating to the directory where the LM is located) with the version number on the 
product CD. To do this:

a. Type the following commands and press enter:

>lmutil lmver lmgrd.exe
lmutil - Copyright (C) 1989-1997 Globetrotter 
Software, Inc.
FLEXlm Copyright 1988-1996, Globetrotter Software, 
Inc.
FLEXlm 5.12a (libmgr_s.a), Copyright (C) 1988, 1997 
Globetrotter Software, Inc.

b. Determine the version number on the product CD:

— Insert the product CD and open a DOS prompt.
— Type: lmutil lmver lmgrd.exe and press Enter.
— If the CD has a newer version, update the LM by selecting the option on 

the product CD for installing the Compuware License Manager.

Troubleshooting for Windows
FLEXlm License Server is not listed in Services List

This only applies to Windows NT and 2000; other Window’s versions do not have 
services lists.

� If you did not install a License when the LM was installed, the FLEXlm License 
Server service was not installed. See “License Manager Installation” on page 2-1.

� If you installed the LM in Console mode, it will not be available as a service.

FLEXlm License Server does not start
� If the machine was not rebooted after installation, try rebooting.
� Start the LM by clicking Start>Programs>Compuware>License Manager. If the LM 

does not start, it may throw an exception error to assist in troubleshooting. See 
Appendix B, “Error Messages”.
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� The License File specified as the Master License File has been moved or is not 
located in the specified directory. You may not be able to see a file if your folder set-
tings are preventing you from doing so. To verify that your settings are correct, open 
Windows Explorer and choose Folder Options from the View menu. Click the View 
tab on the Folder Options dialog box. The Advanced Settings options should have 
the Show all files option selected and the Hide file extensions for known file types 
option cleared.

FLEXlm License Server does not recognize a new license

If you run the LM as a Service, it needs to be refreshed after each new license is added.

1. Run the LAU. 

2. Click Tools>Refresh License Server.
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Chapter 3.   License Installation and Management for 
UNIX
The licensing process varies based on the Compuware product being installed, your 
agreement with Compuware, and the platform. Some Compuware products are installed 
on the client and do not require the License Manager, while most others require the 
installation of the License Manager.

If your license has SERVER or DAEMON lines, then you need to install the License 
manager. The only time that you do NOT need to install the License Manager is if you 
have a Node-Locked license. If you have a Node-Locked license for a client machine, all 
you need to do is set the LM_LICENSE_FILE environment variable. See “Set the 
License Environment Variable for Unix” on page 3-6.

When a License Manager is needed, setup involves the following steps:

1. Installing the License Manager and its components. See “Install the License Man-
ager on Unix” on page 3-1.

2. Configure LM and BPS to start whenever the server boots. See “Starting the 
License Manager” on page 3-3.

3. Configuring each client to access the License Manager . See “Set the License 
Environment Variable for Unix” on page 3-6.

4. Creating the options file if necessary. See “Creating an Options File on UNIX” on 
page 3-11.

Install the License Manager on Unix
Before installing the License Manager and its components, note that it may not be 
necessary to completely install the new License Manager. See “Update the License 
Manager on Unix” on page 3-4.
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1. Mount the CD-ROM on your system (root access required).

2. Check to see if the LM is already running by typing in the following command 
(only do this if you have previously installed the LM and there is a chance that it 
may be running) in the Licensing Components directory:

lmutil lmver lmgrd
3. The LM messages will indicate if it is already running. If it is running, type the 

following to bring it down:

lmdown -c
4. Change to the CD-ROM directory. For example, if /cdrom is the mount directory, 

type the following:

cd /cdrom
5. Navigate to the directory on the CD that contains the Compuware license 

executable files for the platform on which you are setting up the License Manager. 
The path is:
<CD drive>\cpwr\cwlm\directory name
Refer to the table below for the directory name for each platform.

6. Type the following to install the License Manager on your system.

./install
7. The install script will ask the name of the target directory for the License Manager. 

We suggest "/usr/local/cwlm" (root access required to create the directory).  If 

Table 3-1.  UNIX directories

Directory Name Platform

cwlmaix64.32 IBM-AIX 64-bit

cwlmaix32.32 IBM-AIX 32-bit

cwlmdec.32 DEC

cwlmhp64.32 HP-UX 64-bit

cwlmhp32.32 HP-UX 32-bit

cwlmlinux Linux

cwlmsun64.32 Sun-Solaris 2.x 64-bit

cwlmsun32.32 Sun-Solaris 2.x 32-bit
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install has a problem creating the directory, you will be notified of the error and exit. 
You will be notified when install is complete.

8. Before you can start the License Management System, you must supply 
Compuware with the "host ID"  of the node on which you plan to run the License 
Manager. To get this ID, type the following command within the directory created 
previously.

lmutil lmhostid
9. The ID the Licensing System uses for validation is displayed. You must send this ID 

to Compuware. Compuware will then send back a license file that replaces the 
demo "license.dat" in the license file directory (usually /usr/local/flexlm/licenses).

NOTE: You must receive a new license file from Compuware before proceeding to the 
next step.

Starting the License Manager
The License Manager can be configured to start automatically (each time the server 
boots) or to start manually.

To validate the license for Compuware products, the LM needs to be running whenever a 
client requests a license check out. 

1. Verify that the licensing components are installed, including the license file.

2. Navigate to the directory containing the LM.

3. Check to see if the LM is already running by typing in the following command:

lmutil lmver lmgrd
The LM messages will indicate if it is already running.

4. Do one of the following:

• If you want to start the LM manually (required each time the Server 
reboots), type the following:

 lmgrd -c /full/path/of/license.dat > license.log &
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• If you want the LM to start automatically each time the Server reboots, fol-
low the suggested procedure below for the appropriate platform:

5. If License Borrowing is enabled (a license file with the BORROW keyword), you 
may want to install the Borrow Proxy Server to start automatically with the License 
Manager. To do so, enter the following command:

nohup bps.run -c <license_file> -p <port_#> -l 
<log_file> &

6. To prevent users from bringing down the LM, use the -p -2 option which goes 
directly after the lmgrd string for any of the platforms above. If this option is 
selected, only Administrators with root privileges can bring down the LM:

nohup  path_to/lmgrd -p -2 -c /path_to/license.dat > 
license.log &

Update the License Manager on Unix
Follow these instructions to update the License Manager on a Unix server. To determine 
whether to install or update the License Manager:

Table 3-2.  Suggested Automatic Startup per platform (UNIX)

Platform Action

AIX In etc/rc.local, enter the following command on one line:
nohup /etc/lmgrd -c /cpwr/license/
license.dat>license.log2>&1&

HP-UX In /sbin/rc3.d, create a file named s95cwlm.server and add the follow-
ing command to the file:

nohup lmgrd -c /cpwr/license/
license.dat>license.log&

Linux In /etc/rc.d/rc2.d, create a file named s95cwlm.server and add the fol-
lowing command to the file:

nohup lmgrd -c /cpwr/license/
license.dat>license.log&

Sun Solaris In /etc/rc2.d, create a file named s95cwlm.server and add the following 
command to the file:

nohup lmgrd -c /cpwr/license/
license.dat>license.log&
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Install only if no previous version of the License Manager (LM) exists on the machine 
you chose as the LM server. From the Compuware product CD, copy the contents of the 
platform-specific /cpwr/cwlm subdirectory to a directory named /cpwr/license on your 
LM server. See “Install the License Manager on Unix” on page 3-1.

Update if a lower version of the LM exists on the machine you chose as the LM server. 
Compare the version number already on the LM server (by navigating to the directory 
where the LM is located) with the version number on the product CD.

1. Navigate to the directory on the Server where the LM is located. Type the following 
and press enter:

lmutil lmver lmgrd 
2. In the response message, note the LM version number. 

3. Navigate to the directory on the product CD where the LM is located. Type the 
following and press enter:

lmutil lmver lmgrd
4. In the response message, note the LM version number. If the version number on the 

product CD is greater than the version number on the Unix box, proceed to install.

License Administration Utility for Unix 
The lmutil utility allows you to perform administrative tasks for the license 
management system. The format for this utility follows:

lmutil command [option1 option 2 ...]
Example:

lmutil lmstat -a
The following are the Commands and Options for lmutil:
Table 3-3.  LMUTIL Commands

Command Argument Description

lmdown -c pathname Performs a graceful shutdown of the 
License Manager. This argument is 
needed if you specified a location for 
the license file other than the default 
and you have not set the 
LM_LICENSE_FILE environment vari-
able. 
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LMUTIL is a utility created by the company that created the License Manager. See 
FLEXlm documentation for more information.

Set the License Environment Variable for Unix
Each client must be configured to automatically access the License Manager or license 
file. If the License Manager is not required (Node-Locked license), a license file is 
required on each client machine. The LM_LICENSE_FILE environment variable is used 

lmhostid Returns the hostid of the machine on 
which you are currently running. This is 
the ID that must be sent to Compuware 
in order for you to receive a permanent 
license file for your License Manager 
machine. 

lmstat

-a

-A

-c pathname

Monitors current licensing activities.

-displays all information

-lists all active licenses

- needed if you specified a location for 
the license file other than the default 
and you have not set the environment 
variable LM_LICENSE_FILE

lmver [file] Reports which version of security a 
product (binary file) has.
Example:
lmutil lmver dx.exe

lmdiag

-c pathname

[feature]

-n

Performs diagnostics to troubleshoot 
problems with the LM system.

Needed if you specified a location for 
the license file other than the default 
and you have not set the environment 
variable LM_LICENSE_FILE.

Diagnose this feature only

Run in non-interactive mode.

Table 3-3.  LMUTIL Commands

Command Argument Description
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on Unix systems to set the Licensing path (Windows uses 
COMPUWARE_LICENSE_FILE variable). Follow the procedures below for your 
platform. It is not necessary to set the server’s license environment variable unless the 
server runs a Compuware product (other than the licensing).

Set the LM_LICENSE_FILE environment variable in the global environment using the 
appropriate command for your particular shell. This will configure each Unix Client to 
access the LM or License File.

C shell
1. If the client is accessing a license file on the client machine, use:

setenv LM_LICENSE_FILE /<full path to license>/
license.dat

2. If the client is accessing the License Manager on a server, use:

setenv LM_LICENSE_FILE 7166@<hostname>

Bourne shell
For the Bourne shell, a two line command is used:

1. If the client is accessing a license file on the client machine, use the following com-
mand and then see step 3:

LM_LICENSE_FILE=/<full path to license>/license.dat 
2. If the client is accessing the License Manager on a server, use the following 

command and then see step 3 (PORT is typically 7166):

LM_LICENSE_FILE=PORT@HOST
3. Type in the following to set the path:

export LM_LICENSE_FILE

Korn shell
1. If the client is accessing a license file on the client machine, use:

export LM_LICENSE_FILE=/<full path to license>/
license.dat

2. If the client is accessing the License Manager on a server, use:

export LM_LICENSE_FILE=7166@<hostname>
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UNIX Components
The installation directory for the UNIX platform includes the following files:

lmgrd
lmgrd is the License Manager application itself.

compuwar
compuwar is the vendor-specific daemon spawned from the lmgrd.

lmutil
lmutil is the License Administration Utility for the lmgrd created by GlobeTrotter 
Software. See “License Administration Utility for Unix” on page 3-5.

Table 3-4.  Unix platform directory

File name Description

lmgrd The License Manager

compuwar The vendor-specific License Manager daemon

lmutil Utility for administering the License Management system

cl_merge License Merge utility

cl_sort License Sort utility

cl_valid License Validation utility

flexlm.rul Rule file used by cl_valid

bps.stat Status checker of BPS 

bps.run Borrow Proxy Server

bps.cfg File not shipped. Create this file to set Borrow restrictions.

bps.stop File not shipped. File created when bps.run is issued.

install Installation script
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cl_merge
cl_merge is a script file called by the install script itself. This script will manually sort and 
merge together two license files. 

Syntax: 

cl_merge -t <target_master_lic_file> -s 
<source_file> 
• <target_master_lic_file> is the target master license file with which source/new 

license file is to be merged

• <source_file> is the new/source license file that is to be merger with the 
target_file 

Sample script usage: 

#!/bin/sh
cp $1 $1% 
echo "merging $1 $2" 

echo "A backup has been written to $1%" 
cl_merge $1 $2 

cl_sort
This script sorts an existing license file and is called by cl_merge. It takes only a single 
argument, a license file.

Syntax:

cl_sort <license_file>

cl_valid
This script validates a license file. It prints errors to stdout. When there is an error, the 
function exist with a 0.

Syntax:

cl_valid -l <license_file> -r <flexlm.rul_file>
• <license_file> is a license file that is to be scanned for errors

• <flexlm.rul_file> is the rule script file that is to be run against the license file
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flexlm.rul
Rule file used by cl_valid.

bps.cfg
The bps.cfg file is an optional file that you can create to set restrictions on borrow enabled 
licenses. 

See “Borrow Proxy Server for Unix” on page 6-9.

bps.run
The bps.run file brings up the Borrow Proxy Server.

Syntax: 

bps.run -c <license_file> -p <port_number> -l 
<log_file> 

• The license_file argument must contain a license 
file with the BORROW keyword.

• Port number must be unique on the network.
See “Borrow Proxy Server for Unix” on page 6-9.

bps.stat
This utility for the Borrow Proxy Server reports the status of the BPS.

Syntax

bps.stat (with no arguments)
See “Borrow Proxy Server for Unix” on page 6-9.

bps.stop
This file is not shipped and is created when bps.run is issued. Use bps.stop to shut down 
the Borrow Proxy Server.

install
The install file is an install script for the License Manager. See “Install the License 
Manager on Unix” on page 3-1.
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Creating an Options File on UNIX
If your license agreement allows users on different clients to simultaneously access 
Compuware products, you need to create an “options file.”

If an options file is required, you can create it in Windows (see “Creating an Options 
File for Windows” on page 2-8) and FTP it to UNIX, or you can edit it manually in 
UNIX.

See Appendix A, “USER_BASED/HOST_BASED License Models” for more 
information about creating an Options file.
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Chapter 4.   License Installation and Management for 
Novell
Novell platforms exclusively use Concurrent-user licenses. Node-locked licenses are not 
supported. In order to install and manage the LM on a Novell network, you will need to 
do the following:

1. Install the License Manager and the license.

2. Configure LM for automatic startup on server boot.

3. Configure each client to access the License Manager.

Installing/Updating the LM on a Novell Sever
Compuware supports Novell NetWare version 3.12+.

1. Place all files from \cpwr\cwlm\novell on the Compuware product CD in SYS or 
VOL at the following path:

SYS (or vol name):\cpwr\license
2. Start Novell NetWare and enter the following command on one line on the Novell 

console:

Load SYS (or vol name):\cpwr\license\compuwar.nlm -c SYS 
(or vol name):\cpwr\license\license.dat
where compuwar.nlm is the Compuware license module from the Compuware 
product CD, and license.dat is the license file from Compuware.

3. To verify proper setup of the LM, enter the following command and search the 
listing for the compuwar.nlm module:

modules
4. Copy the license.dat file into the same directory as the LM. If a license file already 

exists, you will need to merge the new one into the Master.
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5. Open and paste or type your license string into the license file (don’t include infor-
mation preceded with #). For example:

Configure LM for Automatic Startup on Novell
To automatically start the LM when the system is started, add the following command to 
the server’s autoexec.nfc file:

load c:\cpwr\license\compuwar.nlm -c 
c:\cpwr\license\license.dat

where c:\cpwr\license is the Novell server directory where compuwar.nlm is located and 
license.dat is the name of the license file.

Configuring Each Client for Novell
Each client must be configured to access the LM server.

1. Install and configure the IPX/SPX protocol on each client, using the appropriate 
procedure:

• Install the IPX/SPX protocol using Microsoft’s Novell NetWare client.

• Install Novell Client v4.11a (for Windows NT 4.x and above) or v2.5 (for Win-
dows 3x/9x/NT 3.5x), which you can download from www.novell.com.

2. Check that the following files are in the \windows\system or \system 32 directory. If 
Novell Client v4.11a or v2.5 is installed, these files should have been automatically 
copied to this directory. If they are not there, copy them from the 
\public\client\doswin directory on the Novell CD-ROM or the Novell server. 
Unpack them with the nwunpack.exe utility, which is in the same directory.

• nwcalls.dll (\System)

• nwipxspx.dll (\System32)

• nwlocale.dll (\System)

SERVER ServerName 0020af9adb94 TCP:7166
DAEMON compuware ./compuwar
FEATURE xplus Compuware 4.600 12-jan-1999 10 
6C74309CB84A9F07C5ED\
VENDOR_STRING=989898;0;PERM ck=12

Caution
The license string is case-sensitive. 
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• nwnet.dll (\System)

• tli_spx.dll (\System)

• tli_win.dll (\System)

3. Set the COMPUWARE_LICENSE_FILE variable in the registry using the LAU by 
following steps 4-8. For additional information regarding the Current License 
Environment Setting, see “Current License Environment Setting” on page 5-3.

4. Open the LAU.

5. Click Tools>License Path.

6. Define the location of either a License Manager or License.dat license file:

• License file: Use the Browse button to locate a license file. 

• License Manager: Type in a path to a License Manager with a Port@Host 
(7166@hostname) string in the Current License Environment Setting field.

7. Click the Append button.

8. Close the dialog.

9. Set a system communication variable by following the steps below.

� For Windows NT, 2000, XP:

a. Click Start>Control Panel>System>Environment.

b. In the Variable field, type FLEXLM_COMM_TRANSPORT.

— For SPX options: In the Value field, type SPX 
— For TCP options: In the Value field, type TCP

c. Click Set.

d. Click Apply.

e. Reboot the machine. You have completed the license setup process.

� For Windows 3x, 9x, NT 3.5x:

a. Use a text editor to set the communication variable. Open the autoexec.bat file 
and add one of the two following lines exactly as shown, depending on if you 
have the SPX or TCP options:

set FLEXLM_COMM_TRANSPORT=SPX
OR
set FLEXLM_COMM_TRANSPORT=TCP
b. Reboot the machine. You have completed the license setup process.
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Shut Down the LM on Novell
To shut down the LM from the Novell console, key in:

Unload compuwar.nlm
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Chapter 5.   Using the LAU
The License Administration Utility is a Windows-based interface to both the LM and the 
license file. It can be run from the product CD, however, some products install this 
component in the product directory for quick access. 

Figure 5-1. The License Administration Utility

The functions of the LAU include:

� Install a new or Trial License - The Compuware License Install dialog is 
displayed if a product requests a license that does not exist anywhere in the user’s 
Current Licensing Environment. See “Compuware License Install dialog” on 
page 5-2. 

• To set up the Environment before the product starts, see “Current License 
Environment Setting” on page 5-3.

• To Merge a new license file with an existing Master License File, see To 
Merge two license files together.

� Modify the Current License Environment Setting - The License Environment 
provides users with a add/remove paths to different License Managers and License 
files. See “Current License Environment Setting” on page 5-3.

� Verify Host information. The LAU displays Host information in its top pane and 
will print a file with Host information. This file can be used to request a permanent 
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license when sent to Compuware. See “Host Name, Host ID, and HOSTID 
String” on page C-1 and “Request a License from Compuware” on page 5-11.

� Verify license FEATURE line status - - When a License File or License Manager 
is selected in the License File or Server drop down box, the file is scanned and the 
status of all FEATURE lines are displayed. This option is a reporting mechanism 
only and does not “Set” a specific path...all paths in the Environment are always 
scanned when a product requests a License file. See “Checking the LM Status”.

� Compuware Service Handler - The Compuware Service Handler allows system 
Administrators to start and stop the LM as a service, and more. See “Compuware 
Service Handler” on page 5-8.

� Borrow License Client - The Borrow License Client allows clients to disconnect 
from the server and still use a Compuware product. See “Borrow License Client” 
on page 6-13.

� Borrow Proxy Server - The Borrow Proxy Server serves the requests from the 
Borrow License Client and must run whenever the LM is running. See “Borrow 
Proxy Server - Windows” on page 6-4.

Compuware License Install dialog
The Compuware License install dialog appears when a Compuware product requests a 
license from the License Manager and the license does not exist anywhere in the client's 
License Environment Setting. To add a license, use the browse button to navigate to the 
license file, or type in the Port@Host location of a License Manager. 

Figure 5-2. Compuware License Install dialog

See “Configure Clients during Product Installation” on page 2-5.

� The Current License Status listing shows the Product/Release items that are 
available for licensing.
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� The License Location field next to the Browse button should be used to enter a 
path to the license file or License Manager.

� Click Continue to continue product installation after a successful license install.

� Click View license information to see more details regarding the license.

Current License Environment Setting
The Current License Environment Setting dialog allows users to define multiple licensing 
environments for a machine. To open this dialog, click Tools>License Path from the 
LAU. When a new License Environment is created, it will be appended to the License 
Environment path in the Registry.  

� If a change is made to the Licensing Environment (path is added or deleted) and it is 
not displayed in the License File or Server drop-down field of the LAU, restart the 
LAU and the change will be made.

� You can use the registry to verify changes made to the License Path (not 
recommended). The path is located in the following registry location: 
HKEY_LOCAL_MACHINE/SOFTWARE/FLEXlm License Manager/
COMPUWARE_LICENSE_FILE. See “Viewing license variable in Windows 
Registry” on page 5-6. 

Figure 5-3. Current License Environment Setting Dialog

It is often the case that multiple license files (or License Managers) are defined in a user's 
Licensing Environment. All Environment paths in the Registry are scanned when a 
request is made to check out a license for a Compuware product. So, before you run a 
particular product, be sure that one of the paths (Environments) you have defined contains 
the license file with a FEATURE line for the product you want to run. Also, if there are 
multiple old/obsolete paths in your Environment setting, you should delete them to 
improve product response time.
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� Current License Environment Setting field - The first field in the Current License 
Environment Setting dialog displays all currently defined license fields. To remove 
an item from the list, double click it. See “To Edit Existing License Environment 
Paths” on page 5-5

� New License Environment field - This field is to the left of the Browse button and 
is used to add an entry to the Current License Environment field or to edit an 
existing license file. Type the Port@Host location or use the Browse button to 
locate a license file.

• See “To Add a path to the Current License Environment” on page 5-5.

• See “To Edit Existing License Environment Paths” on page 5-5.

� Move button -The Move button in the Current License Environment Setting dialog 
allows users to change the order of the items listed in the Current License 
Environment Setting field. When a Compuware product attempts to check out a 
license, it will search all of the paths in the listing (LM or License.dat file) until it 
finds a valid FEATURE line. Therefore, if many paths are specified, setting the 
most frequently used paths to the top of the order will increase the speed at which 
the Compuware product checks out a license, and ultimately, initializes.

� Append button - After a port@host location is typed in or a user has navigated to a 
license file with Browse, click the Append button to add the path to the Current 
License Environment Setting field.

� Apply Changes button- The Apply Changes button will apply any changes made 
while the dialog is open, including adding, editing, and removing licenses, or 
reordering the paths in the list. 

Create/Update a Licensing Environment
After your trial period has ended, ALL clients need to add the new, permanent license file 
to their License Environment; for Concurrent Licenses, the License Manager needs to be 
installed and run as a Service on a separate server. 

For Clients:

1. Install the Compuware Product.

2. Concurrent licenses only: Have your system administrator give you the location of 
the License Manager (license file). 

3. Open the LAU (on the product CD or installed in the product's directory).

4. Click Tools>License Path.

5. Add a new path in your Licensing Environment to the new License File. See “To 
Add a path to the Current License Environment” on page 5-5
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6. Close the dialog. Close the LAU. The location of this License File/Server has been 
set in your registry. Compuware products will look at this registry setting for the 
location(s) of a valid license.

7. Concurrent licenses only: If you are using License Borrowing, have your system 
administrator give you the IP Address and Port Number of the Borrow Proxy 
Server.

8. Concurrent licenses only: If License Borrowing is enabled in your License File, 
open the LAU. Click Services>License Borrowing>Client. Use the Borrow License 
Client to connect the Borrow Proxy Server.

For Servers that will host the License Manager:

If you are updating a license file only (not the LM), it is recommended that you merge the 
new license file with the old one. After the new license file is merged, use the Compuware 
Service Handler to "Reread" the new Master License file.

For first time installations:

1. Concurrent licenses only: The Administrator must install and run the LM as a 
Service if the license is Concurrent. See “License Manager Installation” on page 
2-1.

2. Concurrent licenses only: The Administrator must install the License Borrowing 
components and start the Borrow Proxy Server if any FEATURE line in the license 
file contains the keyword BORROW. See Borrow Proxy Server dialog.

To Add a path to the Current License Environment 
1. Open the LAU.

2. Click Tools>License Path.

3. Use the Browse button to locate a license file, or type in a path to a server with a 
Port@Host string in the Current License Environment Setting field.

4. Click the Append button.

5. Close the dialog.

To Edit Existing License Environment Paths
1. Double click a path in the Current License Environment Setting field. The path will 

be removed from the Current License Environment Setting field and will be placed 
in the New License Environment field.

2. Make changes to the field and then click Append.

3. Click Apply Changes.
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To Remove a path within the Current License Environment 
1. Open the LAU.

2. Click Tools>License Path.

3. Double click the path in the Current License field to remove it.

4. Click Apply.

5. Close the dialog.

Viewing license variable in Windows Registry
Location of the license file can be found in the Window’s Registry:

1. At a command prompt, type in REGEDIT. 

2. When the Registry Editor Window opens, click the HKEY_LOCAL_MACHINE 
node.

3. Click the SOFTWARE node.

4. Click on the FLEXlm License Manager node. The 
COMPUWARE_LICENSE_FILE string will contain a value indicating the 
path(s) to all of the license files or license Managers.

Merge License Files dialog
The Merge License Files dialog allows users to enter a source and target License File and 
have the LAU automatically merge them. Do not be confused with "License File" and 
"Master License file" terminology. Compuware recommends keeping all License Files in 
a single Master License File (the Merge Process), for easier maintenance. When two 
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License Files are merged together, they are simply combined and referred to as a "Master 
License File". 

Figure 5-4. The Merge License Files dialog

The Merge License File process/dialog is also issued during the Installation of the 
License Manager. The process is the same, but the dialog name changes. See “License 
Installation dialog for the License Manager” on page 2-4.

The Merge License Files dialog contains the following features:

� Target field - The Target Field in the Merge License File dialog describes the 
original, existing license file. 

� Source field - The Source Field in the Merge License File dialog describes the new 
license file that will be added to the Target field license file

� Merge button - The Merge button will begin the Merge process. See below.

During the Merge process, the following will happen:

1. The source file (new license file) will be opened and merged with the target file 
(original Master License File) creating a new Master License File.

2. The new Master License File will be sorted by the ISSUE DATE string in each 
FEATURE line.

3. The Merge process will NOT comment out any lines.

4. The Merge process will NOT remove any lines from either the source or target files.

5. After the Merge process is complete, the new Master License File will be put 
through an internal "Validity Check".

6. If the Master License File contains errors, then an Error dialog will display 
regarding the error. The Error dialog will have Abort/Continue buttons. If Continue 
is clicked on a Master License File containing errors, the Master License File will 
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be saved with errors. If Abort is clicked, then the original license file (the target file, 
in step 1) will be restored.

7. A backup copy of the file is saved with the name License.dat%.

Checking the LM Status
To view the status of the LM or a license file, run the LAU. 

Select a license file or server from the License File or Server list box.

Each feature line in a license is displayed in the Licenses pane with verification and count 
information. Select a product in the bottom listview pane, and click the Details button to 
access specific product details. You can also view the On-Line Help or print a license file.

Compuware Service Handler
The Compuware Service Handler provides system administrators with the ability to Start 
and Stop the License Manager. Administrators can also add, flush and view log files, or 
modify and reread license files. 

To view the Compuware Service Handler, click Services>LMGRD from the LAU. Only 
Administrators (machines designated as License Manager Hosts) will be able to select 
this item from the LAU Services menu. Closing the Compuware Service Handler dialog 
will NOT stop the License Manager from running as a service. 
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Note: During installation of the License Manager, the Compuware Service Handler will 
start and take requests to start the LM as a service. The Compuware Service Handler will 
not open if the current machine's Host Name and HostID do not match the Host Name 
and HostID present in the License File.

Figure 5-5. The Compuware Service Handler for FLEXlm

The following controls are located on this dialog:

� Use Log File checkbox - The Use Log File checkbox specifies if the License 
Manager will write its status into a log file. When the checkbox is clicked, the Log 
file name field, Browse, View and Flush buttons are all enabled. Compuware 
recommends specifying a Log file before the Service is started so that License 
Manager diagnostics are recorded. 

� Log File Name field - The Log File Name field designates the location of the log 
file into which the License Manager will write its diagnostics. To select a local log 
file, click the Browse button and navigate with the Open dialog. Note: If a new Log 
File is specified in the Log file name field, its parent directory must exist.

� View Log File button - When the View Log File button is clicked, a separate log 
file is opened displaying the contents of the log file.

� Browse Log File button - The Browse Log File button displays the open dialog 
used to navigate to an existing log file.

� Flush Log File button - The Flush Log File button will clear the contents of the log 
file specified in the Log file name field. A good troubleshooting technique is to 
Flush the Log file if repeated errors occur. This way, the only items written into the 
log file will be the trapped diagnostics.

� Specify License File checkbox - Before the License Manager can run as a Service, 
a License file needs to be specified in the License File field. When the Specify 
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License File checkbox is clicked and set to true, the License File field, Browse, 
View, and Edit buttons will all be enabled.

� License File field - The License File field is used to specify the license file that the 
License Manager will use while it is running as a service. To change the License 
File, either type in the path to a new license file or use the Browse button to locate a 
local copy.

� View License File button - The View License File button will open up the License 
File specified in the License File field and display it in a separate dialog.

� Browse License File button - The Browse License File button is used to locate a 
local license file.

� Edit License File button - The Edit License File button will open up the License 
File specified in the License File field using Notepad or the system's default text 
editor. Changes made to this file are saved.

� Start Service button - The Start Service button will start the License Manager 
using the Log File and License file specified in the fields in the Compuware Service 
Handler dialog. Compuware recommends specifying a Log file before the Service is 
started so that License Manager diagnostics are recorded.

� Stop Service button - The Stop Service button will stop the current License 
Manager. A message will display asking if you want to run the License Manager as 
a Service the next time the machine reboots. If you choose Yes, the License 
Manager will be added as a Service. If you choose No, it will be removed and will 
no longer be a Service.

� Reread Licenses button - The Reread License button forces the License Manager 
to Reread the License file specified in the License File field. Administrators would 
use this button if a new and existing license file have recently been merged or a new 
license file was added to replace the old license file. It is not necessary to Stop or 
bring down the License Manager to Reread a License File unless the SERVER or 
DAEMON lines are modified.

To Start the License Manager
1. Open the LAU.

2. Click Services>LMGRD to open the Compuware Service Handler.

3. If the Compuware Services Handler reports that the License Manager is down, click 
the Use Log File check box and specify a log file.

4. Click the Specify License File checkbox and browse for the license file to add it.

5. Click the Start Service button.
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To Stop the License Manager
1. Open the LAU.

2. Click Services>LMGRD to open the Compuware Services Handler.

3. If the Compuware Services Handler reports that the License Manager is running, 
then click the Stop Service button to stop the LM as a service.

4. You will be asked if you want to start the LM as a Service the next time the machine 
reboots. Choose Yes/No.

To Reread a License File
1. Open the LAU.

2. Click Services>LMGRD to open the Compuware Services Handler.

3. Click the Reread License file button.

To Clear the Log File
1. Open the LAU.

2. Click Services>LMGRD to open the Compuware Services Handler.

3. Click the Flush button.

Request a License from Compuware
To obtain the permanent license, e-mail the file host-info.txt to Compuware License 
Management at license_mgt@compuware.com. You can also contact your sales 
representative. When you receive your license file from Compuware, copy the file onto a 
location on your disk and put it either:

� In the product directory for node-locked models. See “Current License 
Environment Setting” on page 5-3.

� With the License Manager for concurrent models. See “Configure Clients to 
access the LM on Windows Server” on page 2-5.
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Chapter 6.   License Borrowing
License borrowing enables users to check out Concurrent licenses from the License 
Manager and then use a Compuware product disconnected from the network. When a user 
reconnects to the network, the license can be checked back in, available for all users. 

The License Borrowing architecture consists of two components: 

� The Borrow Proxy Server (BPS) - allows a system administrator to monitor 
License Borrowing activity.

• For Windows - see the “Borrow Proxy Server - Windows” on page 6-4.

• For Unix - see the “Borrow Proxy Server for Unix” on page 6-9.

� The Borrow License Client (BLC) - allows an end user to check licenses in and 
out. This utility is only available for Windows operating systems.

To enable License Borrowing, the following items are required:

� A concurrent license file with the “BORROW” keyword.

� The BPS installed in the same directory as the LM. 

� The BPS running whenever the LM is running.

� The BLC application installed on a client’s machine.

Installation of License Borrowing Components
Installation of License Borrowing components is handled with the installation of the 
License Manager for both Windows and Unix. The BPS needs to be installed and run in 
the same directory as the License Manager. 

� For Unix,  see “To Install the Borrow Proxy Server on Unix” on page 6-10.

During installation of the License Manager, the new License File will be scanned, if it 
contains the keyword BORROW, the Borrow Proxy Server will be installed.
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The Borrow License Client application needs to be installed on each machine that can 
borrow licenses. A system administrator should verify that each client machine that will 
borrow licenses has the BLC installed. The BLC cannot be installed on the same machine 
as the Borrow Proxy Server, and vice versa. Compuware products are responsible for 
installing the Borrow License Client. 

The LM needs to be installed and running before the installation of the BPS. For BPS and 
LM installation procedures on Windows, see “License Manager Installation” on page 
2-1.

License Borrowing Process
The following is an overview of the licensing borrowing process:

1. The BPS is installed and is started as a Service by the System Administrator, EACH 
and EVERY time the License Manager runs. 

2. A client installs a Compuware product and the Borrow License Client.

3. A client runs the BLC application.

4. When the BLC loads, it communicates with the BPS to verify license status.

5. The client selects an available license to borrow.

6. The client enters the amount of days to borrow the license.

7. The client commits the request by clicking “APPLY”.

8. The BLC submits the request to the BPS. After authorization, the user can Detach 
the laptop from the network and use the Compuware product remotely.

Figure 6-1 shows the License Borrow process before/after a transaction.
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Figure 6-1. Borrow License process before/after a Transaction

After a successful Borrow transaction occurs, a license file is created within the BLC and 
the Compuware product uses this license file on which to run. When running the 
Compuware product disconnected from the network, it is not necessary to have the BLC 
running. When the product starts to run, a dialog will inform the user how many days are 
remaining on the borrowed license.

Figure 6-2 shows the Compuware product and the License Borrow components after a 
request transaction is complete and the client is detached from the network.

Figure 6-2. License Borrow process after Borrow transaction
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Borrow Proxy Server - Windows
The Borrow Proxy Server is the application that provides the borrowing capability for 
Compuware products. The BPS is a proxy server that needs to run in conjunction with the 
License Manager. This means that whenever the LM is running, the Borrow Proxy Server 
must run, even if there are no current borrow transactions that will take place. 

The “BORROW” keyword in the license file dictates whether installation of the BPS is 
required. If your license file contains the keyword “BORROW”, installation of the BPS 
is required. If this is the case, Compuware products will not run unless the BPS and LM 
are running.

The Borrow Proxy Server dialog is for System Administrators to monitor and restrict 
License Borrowing. The Borrow Proxy Server dialog is just a GUI front end to the service 
itself; if the BPS is hosted on  Windows NT, 2000, or XP, users can shut down the dialog 
and still use the BPS. If the BPS is hosted on Windows '98, '95, or ME, however, the GUI 
itself is the Service and should not be brought down unless the License Manager is also 
brought down. 

Like the BLC, the Borrow Proxy Server has two views: the “Borrowed Licenses” view is 
the default view and displays the Host, Product, Version, and Time of all current borrow 
transactions. See Figure 6-3 on page 6-5. The “Policy Settings” view displays the 
licenses that are available for the users to borrow. This view enables the BPS 
administrator to limit:

� Number of days a certain license feature may be checked out

� How many licenses out of the current sum of licenses may be borrowed. For 
example, if License feature x has 50 licenses available, the administrator could limit 
the amount of borrowable licenses to 10, or any number less than or equal to the 
sum.
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Figure 6-3. Borrow Proxy Server default view

Borrow Proxy Server Features
The following controls are located on the Borrow Proxy Server:

� Server Name field - The Server Name field on the Borrow Proxy Server is located 
in the top frame and identifies the Server Name of the License Manager to which 
the BPS will connect. The Server name is automatically known by the BPS if it 
exists in the same directory as the LM.

� Port Number field - The Port Number field on the Borrow Proxy Server is located 
in the top frame and identifies the Port Number on which the License Manager is 
listening. To edit the Port Number field, Stop the BPS and modify the value.

� Policy Settings button - The Policy Settings button opens the Borrow Policy 
Settings dialog.

� Hostname item - Each Hostname item contained in the Borrowed Licenses listing 
represents a single client who has borrowed a license.  Each Hostname item has the 
following attributes:

• Product - product name that has been borrowed

• Version - version name of the product that was borrowed

• Time Remaining - length of time before the borrowed license will expire

� BPS-Status field - The BPS-Status output field contains output messages from the 
Borrow Proxy Server to the current user giving borrow transaction status.
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� Start BPS button - The Start BPS button will attempt to connect the Borrow Proxy 
Server to the License Manager. The License Manager must be running.

� Stop BPS button - The Stop BPS button will disconnect the Borrow Proxy Server 
from the License Manager.

� Borrow Policy Settings dialog - The Borrow Policy Settings dialog gives a system 
administrator the ability to control how many and how long each product may be 
borrowed. To modify the settings for a specific product, see “To Change Borrow 
Policy Settings” on page 6-7.

• Product item - Each Product item contained in the Borrow Policy Settings 
listing represents the type of FEATURE lines available in the license file. To 
restrict Borrowing on a given Product item, select it and modify the Max 
Length field or the Reserved field.

• Max Length field - When a Product item is selected in the Borrow Policy 
Settings listing, the Max Length field will display allowing an administrator to 
set the maximum amount of days that the type of selected product may be 
borrowed.

• Reserved field - When a Product item is selected in the Borrow Policy Settings 
listing, the Reserved field will display allowing an administrator to Reserve a 
certain number of licenses that are not available for borrowing. For example, if 
the total license count for a given feature is 6, and 4 is entered into the Reserved 
field, only 2 licenses will be available to borrow.

• Apply button - The Apply button in the Borrow Policy Settings dialog will 
apply changes made from the Max Length field or the Reserved field.

To Connect to the License Manager 
In order to connect the Borrow Proxy Server to the License manager, the License 
Manager must be running. The best way to connect the BPS to the LM is during the LM 
installation. See “License Manager Installation” on page 2-1.

1. From the LAU, click Services>License Borrowing>Proxy Server to open the BPS 
dialog.

2. Verify that the License Manager's Host name appears in the Server name field.

3. Verify that the License Manager's Listening port number appears in the Port 
Number field. These items should appear automatically from installation.

4. Click Start BPS.
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To Monitor Borrowed Licenses 
Use the default view of the BPS to monitor Borrowed licenses. When the BPS opens, all 
Borrowed Licenses will display in the Borrowed Licenses listing.

To Change Borrow Policy Settings 
1. From the LAU, click Services>License Borrowing>Proxy Server to open the BPS 

dialog.

2. Click the Policy Settings button.

3. Click on a product in the product listing to select it.

4. To set the maximum amount of days that a client can borrow a license of that type, 
key a number in the Max Length field.

5. To Reserve a number of licenses that cannot be borrowed, type a number in the 
Reserved field.

6. Click Apply and then close the dialog.

To Start the Borrow Proxy Server as a Service
The Borrow Proxy Server can only be started on the machine that is hosting the License 
Manager. The BPS must have been installed with the LM in order to start it. Compuware 
recommends that you install and run the BPS at the same time that you install and run the 
License Manager. See “License Manager Installation” on page 2-1. Doing this, you 
will have the option of adding the License Manager and Borrow Proxy Server as services. 

To start the BPS in Windows:
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1. From the LAU, click Services>License Borrowing>Proxy Server to open the BPS 
dialog. If the Proxy Server menu item is disabled, it means that the current machine 
is not a License Server (current machine is a client) or the current license 
environment does not contain a license file with a SERVER line.

Figure 6-4. Starting the BPS from the LAU.

2. If the Proxy Server is already running, the following error message will display:

When the BPS starts, status of the License Manager is displayed:

Figure 6-5. LM status displayed on the Borrow Proxy Server

The BPS can run without the LM running, but Client requests for license borrowing will 
not be accepted.

License 
Manager 
status
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3. Click the Start BPS button on the Borrow Proxy Server. If the BPS is not already 
installed as a service in Windows NT, 2000, or XP, the following message appears:

� If you click “Yes”, the BPS will be installed as a service and run automatically each 
time the machine is rebooted. You will receive several messages stating the status of 
the automatic update and that other users must have your same permissions to run 
the BPS.

� If you click “No”, the BPS will run in the foreground of the current session.

4. The BPS - Status field will display messages indicating the success or failure of 
starting of the BPS.

To Stop the Borrow Proxy Server
1. From the LAU, click Services>License Borrowing>Proxy Server to open the BPS 

dialog.

2. If the Stop button is disabled, then the BPS is already stopped. When you click Stop, 
you will be asked if you want to start the BPS as a Service the next time the machine 
runs. It is recommended that you choose Yes so that you do not have to manually 
restart the BPS when the Server boots.

3. The BPS will stop, invalidating all License Borrowing and checking out for all 
clients.

4. To manually uninstall the BPS, see “Manually uninstall the LM or Borrow Proxy 
Server” on page 2-6.

Borrow Proxy Server for Unix
The Borrow Proxy Server for Unix can run on the following Unix platforms:

� DEC

� HP-UX (32-/64-bit)

� IBM - AIX (32-/64-bit)

� Linux (Redhat Linux)

� Novell

� Sun Solaris 2.x (32-/64-bit)
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To Install the Borrow Proxy Server on Unix
The Borrow Proxy Server is installed using the install script, during License 
Manager installation. See “install” on page 3-10.

� For complete License Installation details, see “License Installation and 
Management for UNIX” on page 3-1.

To Start the Borrow Proxy Server for Unix
1. Verify that the Borrow Proxy Server is installed by navigating to the directory 

containing the License Borrowing Components. Type the following:

$ls
2. Among the files, you should see “bps.run”, and “bps.stat”.  If you do not 

see the files, re-run install (see “install” on page 3-10).

3. Type in the following:

$bps.run -c (license file) -p (port number) -l [log 
file]

4. This will create a file called bps.stop, which is used to shut down the Borrow 
Proxy Server.

5. See “To Report on the Borrow Proxy Server for Unix” on page 6-10.

To Stop the Borrow Proxy Server for Unix
1. Navigate to the directory containing the License Borrowing Components.

2. Type in the following:

$bps.stop

To Report on the Borrow Proxy Server for Unix
1. Navigate to the directory containing the License Borrowing Components.

2. Type in the following:

$bps.stat
3. If the Borrow Proxy Server is running, the following will display, otherwise, you 

will get a message regarding the problem. 

bps.stat - Copyright (C) 2000,2001 Compuware Corporation
bps status: running
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The following items describe the Header fields in the report above:

� User - The User field represents the user who has borrowed a product.

� Hostname - The hostname field represents the hostname of the user who borrowed 
the license.

� Product - The product field is the product that the user borrowed.

� Version - The version is the version of the product that the user borrowed.

� dd:hh:mm:ss - This time field represents the time remaining in the borrowed 
license.

To set restrictions on the duration and amount of users that can borrow a license, see the 
next section.

To Set Restrictions on Borrow Enabled licenses for the BPS for Unix
A system administrator can create a special file that will allow setting restrictions on the 
number of days a license can be borrowed, and how many licenses of a certain type can 
be borrowed.

1. Create a file named bps.cfg and place it in the same directory as the License 
Borrowing components.

2. Open the file. The file will be comprised of Keywords, parameters, and comments 
when necessary. The file should follow the format below:

user hostname product version dd:hh:mm:ss

=========== ========== ======== ======= ===========

Win_98.User fh18419 qaload 03.10 00:23:55:07

Win_98.User fh18419 xpdev 03.40 00:23:55:07

PFHSSSx sfa10xx6nt NPP 01.00 26:06:02:58

PFHSSSx sfa10xx6nt FE 02.70 00:23:55:07
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The following sample file shows how system administrators can create the bps.cfg file to 
restrict License Borrowing. Note: Use either all caps, or all lower case, with keyword 
blocks in the following order: (1) RESTRICT (2) MAX_TIME (3) COMMIT (4) END. 
Max_time or commit may be ommited, but Restrict and End are required.

# bps.cfg
# THIS FILE IS USED TO RESTRICT LICENSES BORROWING 
# FOR ALL BORROW-ENABLED LICENSES
# // FIRST RESTRICT FEATURE. THE FOLLOWING RESTRICTS
# THE PRODUCT QALOAD, VERSION 03.10, TO ONLY 1
# LICENSE THAT CLIENTS CAN BORROW

restrict(qaload,03.10)
  commit(1)
end

Table 6-1.  Keyword definitions for bps.cfg

Keyword-Parameter syntax Definition

RESTRICT(prod_name, prod_version) Restrict designates the beginning of a 
FEATURE restriction. Only 
FEATURE lines in a license file can 
have a RESTRICT.

�  prod_name = name of product 
as it is defined in the license file.

�  prod_version = version # or 
borrow-enabled product

MAX_TIME(max_number_of_days) Maximum number of days a product 
can be borrowed. Cannot exceed 365 - 
which is BORROW maximum 
duration

COMMIT(number_of_licenses) This is the number of licenses that are 
allowed to be Borrowed. Cannot 
exceed available license count

END Ends a unique RESTRICTION 
BLOCK.

# Use the # sign for a comment.
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# //SECOND RESTRICT FEATURE. THE FOLLOWING RESTRICTS
# THE PRODUCT XPDEV, VERSION 03.40, TO ONLY 10
# LICENSES THAT CLIENTS CAN BORROW FOR ONLY 30 DAYS

restrict(xpdev, 03.40)
   max_time(30)  
   commit(10)
end

Borrow License Client
The Borrow License Client is a Windows-based application that is used to check licenses 
in and out of the Borrow Proxy Server. The user can then detach the client from the 
network and use the Compuware product with a borrowed license. This borrowed license 
is identical to the original license and allows the Compuware product to function as if it 
were connected to the License Manager. 

The Borrow License Client application is installed with the Compuware product and is in 
the same directory as the LAU. The BLC needs to be installed on the computer on which 
the Compuware product is installed (see Figure 6-2, License Borrow process after 
Borrow transaction, on page 6-3).

It is not necessary to start the BLC to run a Compuware product on a detached 
workstation. You only need to run the BLC to check out a license, to check in a license, 
or to view the status of all checked out licenses on a client machine. When the BLC runs, 
it opens up in the “Edit Transactions” mode. In this mode, you can borrow and return 
licenses. The “Time Remaining” mode provides a listing of the Product, Version, and 
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Time Remaining for each borrowed transaction. There are two buttons to toggle between 
the modes. See Figure 6-6.

Figure 6-6. Borrow License Client Edit Transactions mode 

Borrow License Client Features
To get started with Borrowing licenses, review the available features on the Borrow 
License Client found below, and then use the headings following these items to Connect 
to a BPS, Borrow and Return licenses, etc.

� Server field - The Server drop-down field defines the server name where the 
Borrow Proxy server is running. To define a Borrow Proxy Server, click the Define 
Server Location button and add a Server in the Define Server dialog. An alternative 
method to modify the values in the Server field is to open the bpsHosts.txt file. See 
“To Connect to a Borrow Proxy Server” on page 6-17.

� Define Server Location button - The Define Server Location button opens the 
Define Server dialog.

� Delete Entry - The Delete Entry button will delete the currently selected Server 
from the Server field.

� Auto Return - The Auto Return button will automatically return all borrowed 
licenses to the Borrow Proxy Server when the client machine re-establishes a 

“Edit Transactions” mode “Time Remaining” mode
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connection with the network (as long as Detach is not clicked). The Auto Return 
button acts like a true/false checkbox; meaning, if it is clicked (true), it will remain 
clicked until it is clicked again (default, false). The default value is "not clicked". If 
Auto Return is clicked when the client reconnects, ALL licenses will be returned to 
ALL proxy servers defined in the Server drop down field.

� Detach - The Detach button will immediately force the client's workstation to use 
Borrowed Licenses. The Detach button acts like a true/false checkbox; meaning, if 
it is clicked (true) it will remain clicked until it is clicked again (default, false). If no 
licenses are borrowed, Compuware products will not run. Be sure to click the 
Detach button after the licenses are checked out and to set it to false (default value, 
or not clicked) when reconnecting to the network.

• The Detach functionality can be used to run a Borrowed license if the network 
or Server where the License Manager and Borrow Proxy Server are located is 
experiencing difficulty.

� Define Server Dialog - The Define Server dialog allows clients to create separate 
locations for multiple Borrow Proxy Servers. Example: if there is a BPS on a Unix 
box and also on a Windows box, two different connections can be established. It is 
possible to Borrow licenses from any Borrow Proxy Server to which a client can 
connect. 

• Identifier - The Identifier field in the Define Server dialog is the unique name 
that will appear in the Server field of the BLC dialog.

• BPS Hostname or IP Address - This field in the Define Server dialog defines 
the Host name or IP Address of the Borrow Proxy Server to which the Borrow 
License Client will connect.

• BPS Listening Port - The BPS Port identifies the TCP/IP Port on which the 
Borrow Proxy Server is listening.

� Available Licenses Product item - Each Product contained within the Available 
Licenses listing is a FEATURE line in the active license file that contains a 
BORROW keyword. This product may be borrowed onto the client's machine. 
When a Product item is selected with a mouse click, the Borrow button is enabled. 
Clicking the Borrow button will begin the transaction process. See “Enter the 
Number of Days dialog” on page 6-20. The Available Licenses listing also 
includes the Product Version item and the Expiration date item of the Borrow 
transaction.

� Borrowed Licenses item - Each Product item within the Borrowed Licenses listing 
is a product that has already been borrowed (or will be, "on Apply").  To return the 
item to the Borrow Proxy Server, click the Return button.

� Borrow button - The Borrow button on the Borrow License Client will become 
enabled when a Product item is selected from the Available Licenses listing. When 
the Borrow button is clicked, the Enter the Number of Days dialog will display.
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� Return button - The Return button on the Borrow License Client will become 
enabled when a Product item is selected from the Borrowed Licenses listing.

� Apply Transaction button - The Apply Transaction button will apply a given 
transaction after the Borrow or Return buttons are clicked.

� Edit Transaction button - The Edit Transaction button is clicked (selected) by 
default and provides the default view for the Borrow License Client. The default 
view contains the following:

• Available License listing 

• Borrowed License listing 

� Time Remaining button - The Time Remaining button will hide the Available 
License listing and the Borrowed License listing and display a larger version of the 
Borrowed License listing, including the following fields:

• Product item: displays each product that is currently Borrowed

• Version item: displays the Version number of each Product that is borrowed

• Server: displays the name of the Borrow Proxy Server (see Server field) from 
where the Borrow request originated

• Time Remaining: Displays the time remaining of the Borrow transaction in 
dd:hh:mm:ss format.
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To Connect to a Borrow Proxy Server
1. Contact your system administrator for the Host Name/IP Address and Port Number 

of the Borrow Proxy Server.

2. If the Server Name of the Borrow Proxy Server you want to connect to is not 
selected/created in the Server field of the BLC, click the Define Server Location 
button on the BLC.

3. In the Identifier field, give this server a unique name of your choice.

4. In the BPS Hostname or IP Address field, type in the name given to you by your 
system administrator.

5. In the BPS Listening Port, type in the Port Number specified by your administrator.

6. Click Apply. The name will be placed in the Server field of the Borrow License 
Client.

To Borrow a License
1. Open the LAU.

2. Click Services>License Borrowing>Client.

3. Select the server in the Server field from where the license will be borrowed. If 
there are no servers defined in this field, click the Define Server Location button. 
See “To Connect to a Borrow Proxy Server” on page 6-17.
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4. On the BLC's Available Licenses listing, select one or more products from the list. 
This will enable the “Borrow” and “Apply” buttons.

Figure 6-7. Available Licenses listing

5. Click the Borrow button. When the Borrow button is clicked, the Enter Number of 
Days dialog displays, requesting the amount of days for this borrow transaction. 
Type in the amount of days in the “Enter the number of days” dialog. For more 
borrow duration information, see “Enter the Number of Days dialog” on page 6-
20.

6. Click Ok. When Ok is clicked, focus is returned to the BLC and the licenses are 
moved from the “Available Licenses” listing to the “Borrowed Licenses” listing.

7. To complete the borrow process, click the Apply button.

Figure 6-8. Borrow process

8. When apply is clicked, the Borrow, Return, and Apply buttons are disabled. The 
borrow transaction status is displayed in the “BLC - Status” screen.

9. The messages appear as follows:

***PROCESSING REQUESTS***
- ”PRODUCT NAME & VERSION” acquired

Files selected 
for borrowing

Borrow 
button

Apply
button

Apply
button

Licenses for 
borrowing, 
waiting for 
user to click 
“Apply”

Status
messages
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- ”PRODUCT NAME & VERSION” acquired
10. Click Detach to immediately disconnect from the network. The Compuware product 

will work from the Borrowed license as long as “Detach” is selected, even if the 
client is attached to the network. See “To Detach a Client from the Network”.

At this point, the BLC utility can be shut down and the machine can be detached from the 
network. The Compuware product will display a message with the number of days 
remaining on the borrowed license each time it is run.

To Detach a Client from the Network
1. Open the Borrow License Client.

2. After one or more Licenses are Borrowed, click the Detach button.

3. As soon as the Detach button is turned on, Compuware products will use the 
Borrowed license. You can remove your network connection at any time.

To Return a License
1. Reconnect the machine to the original network.

2. Open the LAU.

3. Click Services>License Borrowing>Client.

4. If the Auto Return button is set to true (clicked) then all licenses will automatically 
be returned to all Proxy Servers when the Detach button is clicked (set to false). 
Otherwise proceed to the next step.

5. Select the product to return in the Borrowed Licenses listing. This will enable the 
“Return” button.

Detach 
button
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Figure 6-9. Return process

6. Verify that the Detach button is not selected.

7. Click the Return button. A message in the status screen will display the following:

A license for “PRODUCT NAME & VERSION” will be 
returned on APPLY.

8. To commit the return, click “Apply”.

9. The product license will be checked back into the License Manager via the Borrow 
Proxy Server. Resume step 5 for any remaining products to return.

Enter the Number of Days dialog 
The length of time that a license can be borrowed from the BPS is specified when the 
Borrow button is pressed. This dialog includes one field that takes an integer (a whole 
number) specifying how many full days the current Borrow transaction will last, from 1 
- 365. 

Note: the Borrow administrator can limit the amount of days that a license can be 
borrowed using the Borrow Proxy Server. 

If a client does not return the license to the BPS before the license expires, two things will 
happen:

� On the client machine: the product that is checked out under the expired license will 
not run.

Return button
License to 
be returned
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� On the server: the BPS will inform the License Manager that a checked out license 
has expired. The LM will make this license available to all users on the network.

View Status of Borrowed Licenses
The status of borrowed licenses can be seen in the “Time Remaining” mode of the BLC. 

Note: status for connections and transactions are always displayed in the “BLC- Status” 
screen.

To view the time remaining for borrowed licenses, click the “Time Remaining” button. 
When this button is clicked, the “Available Licenses” and “Borrowed Licenses” listings 
are hidden and replaced with an expanded version of the “Borrowed License” listing 
which includes a “Time Remaining” column.

Figure 6-10. Time Remaining listing

Click the “Edit Transaction” button to return to the default BLC view.

bpsHosts.txt file
The bpsHosts.txt file contains the strings for the Server field in the Borrow License 
Client. These items can be created with the Define Server Location dialog or can be 
manually typed in the text file.

Note for Administrators: to ensure that each Client connects to the correct Borrow 
Proxy Server, a single file can be created and copied into each Client's Borrow License 
Client directory. the following is an example bpsHosts.txt File:

Borrowed licenses Time Remaining view

Time Remaining button
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# comment
server (Unix Workstation, productionEnt4500, 7123)

The following terms describe the example below:

server = keyword
Unix Workstation = Name of the BPS location
productionEnt4500 = Host Name or IP address of BPS 
7123 = port on which BPS is listening
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Appendix A.   USER_BASED/HOST_BASED License 
Models

USER_BASED and HOST_BASED license models are similar to the concurrent license 
model except that they allow an administrator to restrict certain users/machines from 
checking out a license through the use of an Options File. These license models require 
the use of a license manager.  

The license itself must be a counted license (you cannot specify a license with a user 
count = 0 (uncounted)). These license models use a text file called an Options File to 
specify the licensed users or hosts and must be specified on the compuware DAEMON 
line of the license file. Therefore, two changes are necessary in order to implement this 
license model: changing the License file and adding an Options file. Examples of each 
are provided.

Implementing a USER_/HOST_based License Model
The following steps provide an overview for modifying the License File and creating an 
Options file to implement USER_/HOST_based licensing. 

For a completed License File example, see “Modify License File for USER_/
HOST_Based Licensing” on page A-2.

1. Specify a name for the options file within the license file. If the options file location 
is not in the same directory as the license file, specify the complete path.The options 
file path must be specified on the Compuware DAEMON line of the license file. 
Compuware suggests that you use the suffix ".opt" in the file name. For example:

DAEMON compuware compuwar compuwar.opt

2. Add the "HOST_BASED" or "USER_BASED" literal to the FEATURE_LINE. 
Note that the license type specification is in uppercase and usually appears after the 
VENDOR_STRING field. For example:

FEATURE test compuware 1.000 1-dec-1999 2 
DCA6EE6A58F94072F0F7\
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  VENDOR_STRING=999999;0;PERM USER_BASED ck=101
3. Create an ASCII text file (options file) and name it the same name used in step 1 

above. This file is created and updated at the customer site.

4. Enter your USER, HOST, or GROUP parameters in the options file. See 
“INCLUDE Keyword” on page A-2 and “GROUP Keyword” on page A-3.

Modify License File for USER_/HOST_Based Licensing
The following is an example of a complete license file where feature "test" is 
USER_BASED and "test2" is HOST_BASED:

#Start of license file example
SERVER fh18419 00c04f35d091 TCP:7166

DAEMON compuware compuwar compuwar.opt

FEATURE test compuware 1.000 1-jan-0000 2 \
DCA6EE6A58F94072F0F7 \
VENDOR_STRING=999999;0;PERM USER_BASED \
ck=101

FEATURE test2 compuware 1.000 1-jan-0000 3\
9C668E6A5C3CF3C0DB7E \
VENDOR_STRING=999999;0;PERM HOST_BASED \
ck=81

#end of license file example

Create an Options file from an ASCII text file
There are several keywords necessary to create an Options file The two most important 
keywords are INCLUDE and GROUP. These two keywords are described in detail 
below. For more Options file keywords and information, contact GLOBEtrotter Software 
for a FLEXlm User’s Guide.

INCLUDE Keyword
The INCLUDE statement is used to specify a licensed user or host, the syntax is:

� <product> — The name of the Compuware product. It is possible to define a 
specific version of a product by appending a colon followed by the desired version. 
For example, "test:version=1.1"  would only allow specified users or hosts to run 
version 1.1 of the specified product. If the version modifier is omitted, all versions 

INCLUDE <product> s co t <name>USER
HOST
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of the product can be accessed. There are additional modifiers that are not covered 
in this document.

� USER/HOST — Specify as "USER" for USER_BASED or "HOST" for 
HOST_BASED licenses.

� <name> — Name of the USER or HOST licensed to run the product. Please note 
that host or user name is case sensitive and must match the name used by the 
network name server.

Below is a possible option file for the above license file example:

INCLUDE test USER user1
INCLUDE test USER user2
INCLUDE test2 HOST xx18929
INCLUDE test2 HOST xx18419

Figure A-1. Options file example 1

In this example, users user1 and user2 are licensed to run all versions of product "test" 
and machines xx18419 and xx18929 are licensed to run all versions of product "test2". 
Please note that the license file above specifies a maximum of two users for product "test" 
and a maximum of three hosts for product "test2". 

In this example, all possible users are defined. Any additional users or hosts specified as 
licensed users are ignored and therefore not licensed to run the product. For example, if 
there were four hosts defined for product test2, only the first three host specifications 
would be used by FLEXlm. You have the option of changing or adding names of users or 
hosts up to the specified license count. You cannot specify more users than the license 
file allows. 

If the options file does not exist, there are no licensed users for the product. If a user tries 
to acquire a license and is not specified as a legal user, an error code -39 will appear 
indicating the user or host has not been specified in the options file as a licensed user or 
host.

GROUP Keyword
In lieu of using individual users within the INCLUDE statement, the GROUP keyword 
can be used to define a grouping of individual users. The GROUP keyword appears at 
least two times: (1) One for each Group to include (2) One within the INCLUDE 
statement to specify a GROUP name. 

� The GROUP keyword must be defined before the INCLUDE statement. A separate 
INCLUDE statement is required for each GROUP defined.

� There is a limit to the number of users that can be included in a single GROUP. 
Each defined GROUP should contain no more than 100 users.

� The “<“ and “>” appearing below should not be included in the statements.
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Syntax

GROUP <group_name> <user1> <user2> <userN>
INCLUDE <productname> GROUP <group_name>

Example
GROUP Development jillJack janeDoe marySmithe
GROUP Testing wsWrite satchPage johnDoe
INCLUDE <yourProduct> GROUP Development
INCLUDE <yourProduct> GROUP Testing

Figure A-2. Options file example 2
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Appendix B.   Error Messages
The following error messages may be returned from the Client Server License Manager 
product. If any of the error messages persist after attempting to resolve them with the 
recommended procedure, contact Compuware.

-1 cannot find license file

-2 invalid license file syntax

Description Windows platform:
The license environment is not correctly set in the registry.
Other platforms:
The LM_LICENSE_FILE license environment variable is not defined.
The LM_LICENSE_FILE license environment variable points to a license file that 
doesn't exist.

Resolution 1. To set the license environment in Windows, click "Set Environment" under 
the "Tools" menu of the LAU.

2. Verify that the license has been set up.

3. Make sure that the license file is located in the correct directory.

4. Make sure that the license filename is typed correctly.

Description Internal system error
Resolution Record steps to recreate the problem and contact Compuware
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-3 cannot connect to license server

-4 licensed number of users already reached

-5 no such feature exists

-6 no TCP ‘license’ service exists

Description Internal system error
Resolution Record steps to recreate the problem and contact Compuware

Description You have exceeded the authorized number of licenses for this feature as defined in your 
license file. This error indicates that the maximum number of licenses have been 
checked out from the license server.

Resolution Wait until another user releases a license, making one available for checkout.

Description This error indicates that the license file does not contain a license for the product/
component/feature you are attempting to use.

Resolution If you have licensed this feature, verify that the license has been received and set up.
If the license file has been saved in a format other than plain text (i.e. Rich Text Format, 
MS Word format, etc.), reopen the license and save it in plain ASCII text format.

Description The license file does not contain a port number or the TCP license service does not 
exist.

Resolution � Verify that the port number is specified correctly in the license file.

� Verify that the TCP/IP service exists via PING.
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-7 no socket connection to License Manager server

-8 encryption code in license file is inconsistent

-9 encryption code in license file is inconsistent

-10 feature has expired

Description This error is usually caused by some type of network/communications error. Internal 
system error 

Resolution Contact your network administrator for assistance.

Description The information in the license file does not match what was shipped. This error usually 
indicates that a license file has been altered. This can happen if the file is not copied 
correctly or if someone has attempted to change something in the license file. Typically 
this is due to the license file being corrupted during an edit.

Resolution Perform license setup again with the original license file for this product

Description The hostid contained in the license file for this feature does not match the hostid of the 
machine attempting to run the feature.

Resolution � Confirm that the proper hostname/hostid information was supplied when 
the license was requested.

� If the hardware associated with the HostID has been replaced (either a net-
work card or hard disk), its HostID has changed. Contact Compuware to 
request a new/updated license for this new HostID.

� Run this feature only on the machine(s) specified in the license file.

Description The license for this feature (usually a trial license) has expired, or the system date on 
the computer been set past the expiration date defined in the license file.

Resolution Set the date back to the current date.
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-11 invalid date format in license file

-12 invalid data returned from license manager

-13 no server lines in license file

Description The start or expiration date in the license file is invalid. This error usually indicates that a 
license file has been altered. This can happen if the file is not copied correctly or if 
someone has attempted to change something in the license file. Typically this is due to 
the license file being corrupted during an edit.

Resolution Perform license setup again with the license file for this product.

Description The server returned invalid data or the daemon did not respond within the time-out 
period. This error may be caused by various network/communications issues.

Resolution � Ensure that the license server is running.

� Shutdown and restart the license server.

� If your server is running on Novell NetWare, check the server line contents 
in the license file. It should match the Novell console "config" command's 
output.

� Contact your network administrator for assistance.

Description There is no SERVER line in the license file. This error usually indicates that a license file 
has been altered. This can happen if the file is not copied correctly or if someone has 
attempted to change something in the license file. Typically this is due to the license file 
being corrupted during an edit.

Resolution Verify that the Server and Daemon lines exist in license file.
Perform license setup again with the license file for this product.
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-14 cannot find SERVER hostname in network database

-15 cannot connect to license server

-16 cannot read data from license server

-17 cannot write data to license server

Description The name of the Server does not exist in the DNS or NIS database.
Resolution Contact your Network Administrator to add the Server name to DNS or NIS database.

Description The server or the client could not connect to the license server. This error is usually 
caused by one of the following reasons:
� License server has not been started yet.

� Wrong Port@Host or license file is being used.

� Port or hostname in the license file has been changed.
Resolution 1. Ensure that the license server is running.

2. Shutdown and restart the license server.

3. Verify that you're using the correct environment value.

Description The system cannot read data from the license daemon within the time-out interval, or 
the daemon exited before the system attempted to read data.

Resolution Shutdown and restart license server.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.
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-18 license server does not support this feature

-19 error in select system call

-20 license server busy (no majority)

-21 license file does not support this version

Description The feature (on the server node) has expired, not yet started, or you have an old, 
unsupported version. This usually occurs when a new license has been added to an 
existing license file, but the license server has not been restarted/re-initialized.

Resolution Shutdown and restart the license server.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description The license server is busy (initializing). Requests from clients are deferred during this 
period. This should only occur when using a redundant license server model.

Resolution Retry checkout in a few minutes.
Shutdown and restart redundant license servers.

Description You have an old version of the requested product, and it is not supported in the license 
file. This error usually occurs when you attempt to use a license for a previous version of 
the product.

Resolution Set up a license consistent with the version you are installing/using.
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-22 feature check-in failure detected at license server

-23 license server temporarily busy (new server connecting)

-24 users are queued for this feature

-25 license server does not support this version of the feature

-26 request for more licenses than this feature supports

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description The vendor daemon is busy (initializing). Requests from clients are deferred during this 
period.

Resolution  Retry the request in a few minutes.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description The feature (on the server node) has not yet started, or you have an old, unsupported 
version. This usually occurs when a new license has been added to an existing license 
file but the license server has not been restarted/re-initialized.

Resolution Shutdown and restart the license server.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.
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-29 cannot find ethernet device

-30 cannot read license file

-31 feature not yet available

-32 no such attribute

-33 bad encryption handshake with daemon

Description The Ethernet device could not be located on this system. This would usually occur if the 
Ethernet card has been removed or has failed.

Resolution Ensure an Ethernet card is installed and working.

Description This error usually indicates that the specified license file cannot be read, or that a 
permission/security error has occurred.

Resolution Change the permissions/security on the license so it can be read.

Description You are trying to use this feature before the licensed start date. This error usually occurs 
because the system date on the client or server is set to a date earlier than the start date 
of the licensed feature.

Resolution Set the system date on the client and server to the current date.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.
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-34 clock difference too large between client and server

-35 in the queue for this feature

-36 feature database corrupted in daemon

-37 duplicate selection mismatch for this feature

-38 user/HOST on EXCLUDE for this feature

Description The dates or times on your client and server differ too greatly.
Resolution Synchronize the date on the client and the server.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description This error indicates you are using the license server with a user-based license, and the 
options file specifically excludes your User ID.

Resolution Your license administrator needs to remove your User ID from the exclude list in the 
license options file.
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-39 user/HOST not on INCLUDE for this feature

-40 cannot allocate dynamic memory

-41 feature was never checked out

-42 invalid parameter

-43 no FLEXlm key data supplied in lc_init() call

Description This error indicates you are using the license server with a user-based license, and the 
options file does not specifically include your User ID.

Resolution Your license administrator needs to add your User ID into the include list in the license 
options file.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.
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-44 invalid FLEXlm key data supplied

-45 FLEXlm function not available in this version

-47 clock setting not available in daemon

-48 FLEXlm platform not enabled

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description You are trying to run the software on a platform (i.e. HP, AIX, Windows, etc.) that is 
different from the one you purchased. The machine on which you are trying this is not 
defined in the license file.

Resolution � Confirm that the proper platform information was supplied when the license 
was requested.

� Run this feature only on the platform(s) specified in the license file.
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-49 date too late for binary format

-50 FLEXlm key data has expired

-51 FLEXlm not initialized

-52 server did not respond to message

-53 request rejected by vendor-defined filter

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.
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-54 no FEATURESET line present in license file

-55 incorrect FEATURESET line in license file

-56 cannot compute FEATURESET line

-57 socket call failed

-58 setsockopt() failed

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.
  



B-14     Client/Server License Installation Guide
-59 message checksum failure

-61 cannot read license file from server

-62 network software (TCP/IP) not available

-63 not a license administrator

-64 lmremove request too soon

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description The license for this feature (usually a trial license) has expired, or the system date on 
the computer been set past the expiration date defined in the license file.

Resolution Set the date back to the current date.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.
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-65  bad VENDORCORE struct passed to lc_init()

-66 FLEXlm include file/library mismatch

-71 invalid TZ environment

-72 ‘old style’ vendor keys (3-word)

-73 local checkout filter requested request

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.
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-74 attempt to read beyond the end of LF path 

-75 SYS$SETIMR call failed

-76 internal FLEXlm error

-77 bad version number - must be floating point number, without letters

-78 FLEXadmin API functions not available

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.
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-82 invalid package line in license file

-83 server FLEXlm version older than client’s

-84 incorrect number of USERS/Hosts included in options file

-85 server doesn’t support this request

-86 this license object already in use

Description The information in the license file does not match what was shipped. This error usually 
indicates that a license file has been altered. This can happen if the file is not copied 
correctly or if someone has attempted to change something in the license file. Typically 
this is due to the license file being corrupted during an edit.

Resolution Perform license setup again with the license file for this product.

Description This is caused by having an obsolete license manager with a newer license client.
Resolution Install current license manager.

Description This usually occurs when more users than are licensed for, or no users, are specified in 
the options file.

Resolution Add or delete the users defined in the options file to within the range 

Description This is caused by having an obsolete vendor daemon with a newer license client.
Resolution Install the current vendor daemon.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.
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-87 checkout exceeds max specified in options file

-88 system clock has been set back

-89 this platform not authorized by license

-90 future license file format or misspelling in license file

-91 encryption seeds are non-unique

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description You are trying to run the software on a platform (i.e. HP, AIX, Windows, etc.) that is 
different from the one you purchased. The machine on which you are trying this is not 
defined in the license file.

Resolution Confirm that the proper platform information was supplied when the license was 
requested.
Run this feature only on the platform(s) specified in the license file.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.
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-92 feature removed during lmreread

-93 This feature is available in a different license pool

-94 attempt to generate license with incompatible attributes

-95 network connect to this host failed

-96 server node is down or not responding

Description The local license file and the license file on the server do not contain the same licensing 
information.

Resolution Copy the server license file to the location where the client is reading the license file. Set 
the license file location to Port@Host instead of maintaining copies.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description The license file machine is not running or is not connected to the network.
Resolution Ensure that the license server is running and attached to the network
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-97 desired vendor daemon is down

-98 feature line cannot be converted to decimal format

-99 decimal format license is typed incorrectly

-100 cannot remove a lingering license

-101 all licenses are reserved for others in the options file 

Description The feature (on the server node) has expired, not yet started, or you have an old, 
unsupported version. This usually occurs when a new license has been added to an 
existing license file, but the license server has not been restarted/re-initialized.

Resolution Shut down and restart the license server.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.
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-106 license server out of network connections

-110 dongle not attached, or can’t read dongle 

-111 lmgr.res, windows resource file, not linked

-112 missing dongle driver

-113 2 FLEXlock checkouts attempted

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.

Description Internal system error
Resolution Record procedures to duplicate this error and contact Compuware.
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Appendix C.   Host Name, Host ID, and HOSTID String
The Host Name is the unique name that identifies a computer on a network. A computer 
may have several of these (aliases). The Host ID is the machine identification number of 
a Host. For Windows PCs, this is the Ethernet card ID. HOSTID is a string found in a 
line below the FEATURE line of a license file and typically is the ethernet card of a 
machine. 

Host Name and Host ID 
To obtain a license for your Compuware product, you must give Compuware the host 
information of the machine on which the license will reside. If a License Manager is 
required, this is the server machine; if no server is required, this is the same machine on 
which the product is installed. If you are going to use the LM, you need to supply 
Compuware with the Host ID of the server on which the LM will run, not the Host IDs of 
all of your clients. 

To determine Host information to send to Compuware to request a permanent license:
Table 6-2.  Determine Host Information of Computer

Platform Step Action

Windows 1 Run the LAU.

2 Click File>Save.

3 Choose a directory. Click Save. A text file is saved in this 
location.
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After you receive your license file from Compuware, you can find your Host Name and 
Host ID for your Concurrent licenses in the first line of the license file:

UNIX 1 Navigate  to the directory in which the LM is located (for 
example, /cpwr/license).

2 Enter uname -n. A message like the following is displayed: 
Host Name = fh5222dt.

3 Enter lmutil lmhostid. A message like the following is displayed:
FLEXlm host ID is "00c04fd9ed02

Novell - 
TCP/IP

1  While the server is running, enter the name command.

2 Enter the config command while the server is running. The host 
ID is the node address of the network adapter card.

3 The TCP port_number must be set to 7166 for the LM. Frame 
type of the server's adapter (such as ethernet or token ring) 
must be either compatible with the client workstations or the 
same for the entire network.

Novell - 
IPX/SPX

1  While the server is running, enter the name command.

2 Enter the config command while the server is running. The host 
ID is the node address of the network adapter. The node 
address is the node address of the LM server. The network 
number is the IPX internal network number.

3 In addition to host name and host ID, Compuware needs the 
node address and network number for Novell IPX/SPX.
server's adapter Frame type must be compatible with either the 
client workstations or the same for the entire network.

Table 6-2.  Determine Host Information of Computer

Platform Step Action

SERVER 
keyword

Host name Host ID Port on which the Host is Listening 
for Requests

SERVER sfa15155 00c05f581a0e TCP:7166
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HOSTID
The HOSTID string is only found in Node-Locked licenses and defines the Host ID of 
the client that can execute a given feature. See the example below:

The typical values for HOSTID are either a Host ID from a machine or the keyword 
“ANY”. If you see the keyword “ANY” in your license file, you have either 0 or 1 
licenses; however, the license can run a feature on “any” client machine.

ABCD33NDDMEKK3K \
VENDOR_STRING=989898;0;PERM \
HOSTID=00c00f47fa0e ck=110

FEATURE xpdev compuware 03.40 1-jan-2001 3
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Connect to the License Manager, 6-6
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Create Shortcut to Shutdown LM, 2-8
Create Shortcut to Start LM, 2-7
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Creating an Options File for Windows, 2-8
Creating an Options File on UNIX, 3-11
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Current License Environment Setting field, 5-4
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Delete Entry, 6-14
Detach, 6-15
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E
Edit License File button, 5-10
Edit Transaction button, 6-16
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Korn shell, 3-7

error code- 39, A-3
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F
FEATURE, 5-7
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FLEXlm License Manager, 5-6
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cense, 2-10
FLEXlm License Server does not start, 2-9
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